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ABSTRACT 
 

Internet of Things (IoT) is a technology that allows things to communicate and connect with each other. Change the patterns 

and processes in both industry and agriculture towards higher efficiency. An intelligent farming system (IF) helps to improve 
the growth in farming. IF composes of two main parts which are a sensor system and a control system. The control part which 

watering and roofing systems of an outdoor farm based on the statistical data sensed from the sensor systems. A set of 

decision rules based on the sensed data is developed to automatically decide on whether the watering and roofing system 

should be on or off. As the energy demand and the environmental problems increase, natural energy sources have become 
very important as an alternative to conventional energy sources. The renewable energy sector is fast gaining ground as a 

new growth area for numerous countries. 

The latest generation of convolutional neural networks (CNNs) has achieved impressive results in the field of image 

classification. This project is concerned with a new approach to developing a plant disease recognition model, based on leaf 

image classification, by the use of deep convolutional networks. A novel way of training and the methodology used to 
facilitate a quick and easy system implementation in practice. The developed model can recognize three types of diseases 

of one plant and pesticides and/or fertilizers are advised according to the severity of the diseases. The type of green leaf 

disease is recognized by CNN. After recognition, the predictive remedy is suggested to help agriculture-related people and 

organizations to take appropriate actions against these diseases. 

 

1.INTRODUCTION 

 
Agriculture is one of the most important businesses that mainly affects mankind from the ancient to the 

agricultural revolution in Great Britain England, farming is the way that humans used to harvest plants and 

consumed them in their daily life. Farming has been improved by many technologies. The supporting cropping 

system. In addition to the technologies in the agricultural revolution era, there have been many technologies that 

have impacts on agriculture such as harvest machine, seed drill machine, reaper machine, and the others that can 

reduce manpower and waste time. Recently Internet has been involved in people's daily activities. 

The Internet has been widely used to connect people together, people with devices, or devices with devices. In an 

electronics device, it is embedded with software and sensors for use to commutate and to exchange data with 

other devices and people. When millions of devices are connected together through the Internet, this is called 

the Internet of Things (loT). It encompasses many new intelligent concepts for use in the near future such as 

smart home, smart city, smart transportation, and smart farming 
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2. RELATED WORK 

Image acquisition, preprocessing of images, extraction of features, recognition, and order of plant infection are the 

essential strides for ailment discovery utilizing image Processing. High quality and clarity of enhanced images 

compared to the original image The created handling plan comprises four primary stages as in the accompanying 

two stages are included progressively after the division stage. In the initial step, we recognize the mostly green-

hued pixels. Next, these pixels are concealed dependent on explicit limit esteems that are processed utilizing Otsu's 

technique, at that point those for the most part green pixels are veiled. The other extra advance is that the pixels 

with zeros red, green, and blue qualities and the pixels on the limits of the tainted group (object) were expelled. 

The trial results exhibit that the proposed strategy is a powerful procedure for the location of plant leaves 

infections. They created algorithms proficiency can effectively recognize and arrange the inspected illnesses [1]. 

The primary colors of the color image are red, green, and blue. Because of its range, it is hard to implement the 

application using RGB. They, therefore, convert RGB to gray pictures. Detection of plant disease by some 

automatic technique is beneficial as it reduces extensive monitoring work in large crop farms and distinguishes 

the side effects of the illness itself at very early stages, they presented a survey on different techniques of 

classification [2]. 

Abdul Bari et al used MATLAB in their paper to extract and recover images. The digital camera is used to capture 

images here [3]. 

Prashant and Mrunalini.R. Deshmukh compares the threshold of Otsu and the K is the clustering algorithm for 

the analysis of infected leaves. K's clarity means clustering is more precise than any other method[4]. 

 In his paper, J.K. Patil describes how low-level image features such as color and texture can be extracted [5].  

In his paper, Anand Kulkarni discusses the Gabor filter and ANN respectively for feature extraction and 

classification [6]. 

An Overview of the Research on Plant Leaves Disease location utilizing Image Processing Techniques by Kiran 

R. Gavhale, and U. Gawande, Gavhale and Gawande (2014) introduced audits and outlines picture preparing 

procedures for a few plant animal groups that have been utilized for perceiving plant illnesses.The real systems for 

identification of plant infections are the back proliferation neural system (BPNN), Support Vector Machine 

(SVM), K-closest neighbor (KNN), and Spatial Gray-level Dependency Matrices (SGDM). These strategies are 

utilized to investigate the solid and ailing plant’s leaves [7]. 

Astute Diagnose System of Wheat Diseases Based on Android Phone by Y. Q. Xia, Y. Li, and C. Li, in 2015, 

Xia and Li have proposed the android structure of shrewd wheat ailments analysis framework. In this procedure, 

clients gather pictures of wheat maladies utilizing Android telephones and send the pictures over the system 

International Journal of Pure and Applied Mathematics Volume 119 No. 14 2018, 879- 884 ISSN: 1314-3395 (on-

line adaptation) URL: http://www.ijpam.eu Special Issue ijpam.EU 879 to the server for sickness determination. 

Subsequent to accepting illness pictures, the server performs picture division by changing over the pictures from 

RGB shading space to HSI shading space. The shading and surface highlights

http://www.ijsrem.com/
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of the sicknesses are to be controlled by utilizing the shading minute framework and the dark dimension co-event 

grid. The favored highlights are a contribution to the help vector machine for acknowledgment and the 

recognizable proof outcomes are encouraged back to the customer [8]. 

Usage of RGB and Grayscale pictures in plant leaves malady discovery – a similar investigation by Padmavathi 

and Thangadurai (2016) has given the near consequences of RGB and Grayscale pictures in the leaf ailment 

discovering process. In recognizing the contaminated leaves, shading turns into a vital component to discovering 

the malady power. They have considered Grayscale and RGB pictures and utilized the middle channel for 

picture improvement and division for extraction of the sick bit which is utilized to recognize the sickness 

level. The plant ailment acknowledgment display, in view of leaf picture order, by the utilization of profound 

convolution systems has created. 13 sorts of infections are distinguished from the solid leaves with the ability to 

separate leaves from their environment [9]. 

 

Khirade et al. have examined some divisions and highlighted extraction calculations that can be utilized for the 

recognition of plant maladies by utilizing the picture of their leaves. It is hard to recognize plant infections 

physically because of the prerequisite of unreasonable time, learning of plant illnesses, and many measures of 

work. The creator has separated the whole procedure of plant leaf infection’s location into five stages: Image 

securing, Preprocessing, Segmentation, Feature extraction, and Final arrangement of maladies. Picture 

procurement utilized the changing structure for the RGB leaf pictures. At that point, the picture is pre-prepared 

to evacuate the commotion and upgrade the picture differentiates. The division is accomplished for the parceling 

of pictures into different component parts utilizing k-implies grouping, Otsu channels, and so forth. This 

fragmented picture is additionally utilized for highlight extraction and after that last order is performed 

utilizing different arrangement procedures. Along these lines, plant infections can be proficiently distinguished 

[10]. 

 

Sannakki et al.have utilized a feed-forward back engendering Neural Network-based method for the 

determination and order of sicknesses in grape leaves. Creator has utilized the pictures of the grape leaf with a 

complex foundation for the finding as info. Further anisotropic dissemination is utilized to expel the clamor of the 

picture which is additionally divided utilizing k-implies grouping. At long last outcomes are watched utilizing a 

neural system. Results are investigated wool mold and fine buildup pictures with reproduction in MATLAB. the 

array network is considered with the genuinely positive and false-positive parameters for 

 the approval of results. The creator professed to have the preparation exactness of 100%  whenever utilized tint 

includes alone [11]. 

 

 Kutty et al. have utilized the neural system-based framework to order the watermelon leaf illnesses of Downey 

Mildew and Anthracnose. Creator has determined the genuine positive rate, genuine negative rate, and in general 

exactness for the proficiency of the proposed idea This arrangement depends on the shading highlight extraction 

from the RGB shading model which is acquired from the recognized pixels in the district of intrigue. 

 

The general execution is portrayed with ROC bend having an AUC estimation of 0.5. The genuine 

http://www.ijsrem.com/
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characterization result likewise delineates the estimation of 75.9%.[12]  

 Rothe et al. have proposed design acknowledgment strategies for the discovery and order of cotton leaf 

illnesses of Alternaria, Myrothecium, and Bacterial Blight. The dataset pictures are taken from the field of 

Central Institute of Cotton Research Nagpur. Dynamic form-based division calculation is utilized for the violation 

of unhealthy spots. Creator has likewise recommended some component bearings to the comparable idea for the 

harvests of wheat, orange, citrus and maize, and so on. [13]  

 Pearson, Roger C et al  Among all plant leaf sicknesses, those brought about by infections are the hardest to 

analyze, infections produce no indications that can promptly be watched and regularly effectively mistook 

for supplement lacks and herbicide injury[14]. 

3. SYSTEM ANALYSIS WITH BLOCK DIAGRAM 

 
In System analysis, firstly concentrated on recognizing the green leaf diseases which assist the farmers to take 

proper measurements and increase the production of plants. So, It will start the analysis by collecting a Leaf 

dataset where the processing is also done on the test image. Secondly, It trains the Leaf dataset, Training the Leaf 

dataset is used to train the model (CNN) so that it can identify the test image and the disease it has. Where CNN 

has different layers that are Dense, Dropout, Activation, Flatten, Convolution2D, and MaxPooling2D. After the 

model is trained successfully, the software can identify the disease if the plant species is contained in the database. 

After successful training and preprocessing, a comparison of the test image and trained model takes place to 

predict the disease. And the automated system is proposed for the diagnosis of three common green leaf diseases 

(Brown spot, Leaf blast, and Bacterial blight) and pesticides and/or fertilizers are advised according to the severity 

of the diseases. The type of green leaf disease is recognized by CNN. After recognition, the predictive remedy is 

suggested to help agriculture-related people and organizations to take appropriate actions against these diseases. 

Successful training and preprocessing, a comparison of the test image and trained model takes place to predict 

the disease. The analyzed result is transmitted to the microcontroller for uploading to the IoT cloud and further 

measurements. A moisture sensor is used to detect soil dry and wet states. DHT11 sensor will measure 

temperature and humidity on the farm. Then from the IoT cloud after analyzing the leaf disease we are given the 

respective remedy. 

 

 

Fig:1- A working model 

http://www.ijsrem.com/


          International Journal of Scientific Research in Engineering and Management (IJSREM) 
                    Volume: 06 Issue: 04 | April - 2022                         Impact Factor: 7.185                                  ISSN: 2582-3930                                                                                                                                               
 

© 2022, IJSREM      | www.ijsrem.com                DOI: 10.55041/IJSREM12163                                          |        Page 10 
 

     4. IMPLEMENTATION 

A. Image Acquisition: - In acquisition process, disease images of the plants are capture through the high-

resolution camera. This image is in RGB (Red, Green and Blue) form. Color conversion structure for the RGB 

leaf image created and a device independent color space conversion for the color variation manufacture applied 

such as HIS model. 

B. Image Pre-processing: - To remove noise in image or other object removal, image clipping i.e. cropping of 

the leaf image to get the interested image region. Image smoothing done using the smoothing filter. Image 

enhancement carried out for increasing the contrast. The nature of the image is definitive for the outcomes of 

examination, influencing the capacity to recognize quality under examination and accuracy of consequent 

estimations. Therefore, the accompanying techniques connected to obtain error free picture. 

C. Feature Extraction: - The input image enhanced to protect information of the pretentious pixels before color 

from the background. The color space equally is used to reduce effect of illumination and distinguish between 

disease and non-disease leaf color inventively the resulting color pixels are clustered to acquire groups of colors 

in the image. The pattern is basic description of an article or a quantitative or an element of enthusiasm for an image 

and one or more descriptors of an object or a substance of image from the pattern or pattern is an arrangement of 

descriptors. Features in pattern acknowledgment writing called descriptors. The feature is fundamental for 

separating a class of objects from another class. A strategy utilized to depicting the objects and the objects features 

highlighted. Extraction of features from the article or element of an image produces description of image. 

Soil monitoring with IoT uses technology to empower farmers and producers to maximize yield, reduce disease 

and optimize resources. The sensors that can measure soil temperature, volumetric water content and display the 

real time values to computer graphical user interface (GUI) are used. Input given through wired medium to 

ESP8266 NodeMCU microcontroller from sensors and output sent from microcontroller wirelessly through 

Blynk application integrating with Representational state transfer (REST) application program interface (API). 

Soil temperature sensor DS18B20 is a waterproof sensor probe that has a built in 12-bit analog to digital converter 

(ADC). It works on the principle of direct conversion of temperature into a digital value and storing this value in 2-

byte scratchpad memory. The scratchpad memory then read via the One-wire bus (via data line) by the Dallas 

library in the program. DS18B20 has three pins in total, which are Pin1 (Vcc), Pin2 (Data Pin) and Pin3 (Gnd). 

Soil Moisture Sensor (SMS) is an analog type interface sensor using capacitance to measure dielectric permittivity 

of the surrounding medium. In soil, dielectric permittivity is a function of the water content. The sensor module 

consists of two probes that use to measure the volumetric content of water. When there is more water, soil conduct 

electricity, which means there will be less resistance therefore moisture 

value will be high and vice versa. The two probes act as a potentiometer that use threshold value. This threshold 

value compared with the sensor output value using the LM393 comparator on the sensor module. 

http://www.ijsrem.com/
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STEPS TO IMPLEMENT THE PROJECT 

 

Step – 1: To create a new project, select -> New 

 

 

       Step – 2: To open an existing project example, select File-> Example ->Basics->blink 

 

Step- 3 : Select your Arduino Uno 

Go to Tools ->Board and select your board 

http://www.ijsrem.com/
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Step- 4 : Select your serial port as COM 3 

Tools->Serial port 
 

 

http://www.ijsrem.com/
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Step- 5 : Upload and Compile the program to your board 
 

 

 

 

 

http://www.ijsrem.com/
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Step- 6 Go to things speak ( Cloud Backend ) 
 

 

 

Step- 7 Give your credentials 
 
 

 
 

http://www.ijsrem.com/
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Step- 7 Give your password 

Step- 8 Create a Channel 

Step- 9 Channel has been created 
 

http://www.ijsrem.com/
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Step 10: Open Anaconda prompt, after Installing packages then enter the command 
 
 

 

Step 11: In Anaconda prompt, click on get photo to choose leaf image 
 

 

http://www.ijsrem.com/
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Step 12: click on test folder to select leaf image 
 
 

 

 
Step 13: click on any leaf image and enter open ,and click on analyse image to get the result. 

http://www.ijsrem.com/
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5. RESULTS AND SCREENSHOTS 

These are the results obtained after following the implementations steps: 

 

 

Data after connecting ESP Cable to the Arduino Uno: 
 

Status of the Gtemperature, Ghumidity, Gvoltage, Gmoisture: 

 

For IOT Based Intelligent Farming with IOT, the status of voltage sensors is obtained byplotting 

a graph with gv on Y-axis and date on X-axis. 

The recorded Status of the Gtemperature, Ghumidity, GVoltage, 

Gmoisture: status is highlighted in red marker in the above result. 
 
 

http://www.ijsrem.com/
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Compilation of the code before executing 
 

 

 

Hardware Components ( Arduino Uno) 

 
 

RESULT – After compilation of the code 

which is connected to Arduino Uno 

http://www.ijsrem.com/
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Result of Leaf Image process 

 
 

-Status Of the leaf is shown where it is healthy or not ,name of disease. 
 

Status for remedies given for bacterial spot & unhealthy leaf 

 

6. CONCLUSION AND FUTURE ENHANCEMENTS 

 

CONCLUSION 

 

The proposed system was developed taking in mind the benefits of the farmers and agricultural 

sector. The developed system can detect disease in plants and also provide the remedy that can be 

taken against the disease. Proper knowledge of the disease and the remedy can be taken for 

improving the health of the plant. The proposed system is based on python and gives accuracy. To 

make a decision, the model requires an important information piece which is the sensed data from 

the sensors in the plot. Based on this information, we have set up rules for making a decision in 

our control system. Moreover, we have also provided functions for users to manually control the 

watering and roofing systems by monitoring the sensed data. 

 

FUTURE ENHANCEMENT 

A solution for tracing, tracking & managing your farming activities. Suitable smart agricultural 

technologies targeted for large-scale producers to double their efforts by increasing returns to 

investment and land.To analyze animals to predict disease and give remedy. 

http://www.ijsrem.com/
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